Scratchpads
Training Manual
Before you start...

<table>
<thead>
<tr>
<th><strong>Scratchpads platform</strong></th>
<th>Find information about Scratchpads, browse through sites and apply for a new Scratchpad site</th>
<th><a href="http://scratchpads.eu">http://scratchpads.eu</a></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scratchpads documentation</strong></td>
<td>Find step-by-step documentation (Wiki) about Scratchpads tools and functions</td>
<td><a href="http://help.scratchpads.eu">http://help.scratchpads.eu</a></td>
</tr>
<tr>
<td><strong>Issues queue</strong></td>
<td>Report an issue, ask your questions or find answers or to request a new feature</td>
<td><a href="http://support.scratchpads.eu">http://support.scratchpads.eu</a></td>
</tr>
<tr>
<td><strong>Sandbox</strong></td>
<td>Experiment with all Scratchpads features through this fully functional test site that is resetting every 6 hours.</td>
<td><a href="http://sandbox.scratchpads.eu">http://sandbox.scratchpads.eu</a></td>
</tr>
<tr>
<td><strong>Not covered by the above?</strong></td>
<td>Send us your enquiries to <a href="mailto:support@scratchpads.eu">support@scratchpads.eu</a></td>
<td></td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

## GETTING STARTED
- Logging in the site 8
- Setting up the look of your site 9
- Additional options 10
- Admin menu 11
- Adding a page 11

## ADDING AND MANAGING TAXONOMIES
- Adding a biological classification 15
- Importing a classification from EOL 16
- Importing your own classification 17
- Editing a biological classification 18

## ADDING CONTENT
- Adding literature 21
- Adding and exporting Taxon descriptions 23
- Adding media galleries 25
- Adding images and other media files 27
- Adding locations and specimens 28
- Importing data 31
- Importing classifications (taxonomies) 34
- Importing locations 37
- Importing specimens 39

## FINDING AND EDITING CONTENT
- Searching content 43
- Editing content 45
SELECTING EXTERNAL SERVICES

Linking to Google Scholar
Linking to BHL
Linking to IUCN data
Linking to NCBI
Adding RSS feeds
Twitter feeds

ADMINISTRATOR’S TASKS

Adding and Editing Users
Editing the front page
Customizing dashboard
Adding a forum
Adding a blog
Enabling Google Analytics

HELP AND SUPPORT
Getting started

Introduction to basic Scratchpad training course

The Scratchpad basic training course focuses on creating and setting up a new site, adding various kinds of data and generating taxon pages.

The goal is to give an overview of what a Scratchpad can do and enable you to independently explore your Scratchpad after the event.

By the end of the course you should be able to:

- Customise your site including the front page
- Add and edit biological classifications (manually and through import services)
- Add taxon descriptions and images to create taxon pages
- Import and manage your bibliography
- Find your content using different search methods
- Administer site users
- Control and explore site functionality with site tools

For the purposes of the training courses each participant will be assigned a temporary training site to work with. Your trainer will provide your training site address.

Use the following credentials to log in to the training sites:

Username: username
Password: password

The training sites will be available to the participants for two weeks after the training course. After this period all temporary training courses will be erased.

To apply for a normal Scratchpads site please use the appropriate form located in the scratchpads.eu site.

In order to go through the different functions of Scratchpads you will need to work with some sample material. You can download such material below:

- **Zoological Scratchpad Training files** can be downloaded from [http://help.scratchpads.eu/w/File:Basic_Training_Files.zip](http://help.scratchpads.eu/w/File:Basic_Training_Files.zip)

  or


You can find this training course manual at [http://help.scratchpads.eu/w/Category:Books](http://help.scratchpads.eu/w/Category:Books)
Logging in the site

Instructions

The log in for a training site differs from a new Scratchpad that you have applied for yourself. Use the appropriate method below.

Log in for a new training site

1. Go to the URL of your training site

2. The Log in button is in the upper right corner. Log in to your site with your username and password. The username for all training sites is "username" and the password is "password"

3. Accept the terms & conditions
4. Click Save
5. Click on the "Hello username" link in the upper corner of the site to go to your user account
6. Click on the Edit tab to edit your account data. It is not necessary to change your password
7. Click Save
Log in for a new Scratchpad

1. A few minutes after signing up for a new Scratchpad you will receive an email with a one-time login. Clicking on this link will open a Reset password page
2. Click on the Log in button. Your user account page will open and ready for editing
3. Enter your user data, add a new password, accept the terms & conditions and save

Setting up the look of your site

Instructions

Setting up workflow

After saving the user account page for the first time, you automatically start a workflow that leads you step by step through the basic set up of your site

1. Click the Continue button to start the set up process

2. The first step is writing a welcome message that will appear on the front page of your site. Images will appear separately on the front page, so don't add them to the welcome message
3. The next step is adding an 'About' page. Use the icons of the rich text editor to format your text or to add links or images
4. The third step is selecting a Creative Commons license. The default license is "Attribution CC BY" but you can select a different license if you want. See http://creativecommons.org/licenses/ for an explanation of licenses
5. The last step is selecting which tools you need on your site. Depending on the focus of your site you will need different tools, so for example only taxonomic sites will need EOL taxon pages or specimens. The less tools you choose the easier your site will be to use for people with little Scratchpad knowledge. So only choose those you really need. If you are participating in a training course, don't change any of the tools, just save. You can always activate more tools later by clicking on Structure in the Admin menu and selecting Tools
6. Click on the Finish button to complete the set up. You now have the option to add content, add a taxonomy or get more help
7. Go to the front page of your site by clicking on the home icon in the upper left corner

**Changing theme color**

To differentiate the look of your site from other Scratchpads you can change the color of the theme.

1. To change the theme color, click on the Colors icon in the lower right corner of your Scratchpad, select one of the colors
2. Click Save

**Additional options**

If you don’t complete the set up workflow, you can complete it later by going to the Dashboard and clicking on the respective link.

**Adding a logo**

1. From the Admin menu go to Appearance > Settings
2. Disable Use the default Shortcut icon
3. Click Browse to find the desired logo in your computer
Admin menu

Introduction

The administration pages are accessed via the Admin menu at the top of the Scratchpad.

The Admin menu will be present once you have logged in to a site. The menu items you see will depend on your access permissions.

Instructions

1. The first of the admin links is the Home icon that will always bring you back to the front page of the site.
2. The Dashboard gives administrators a customizable overview of important site information. You can add and remove items from the dashboard (see Customize dashboard), or you can disable the dashboard completely.
3. Under Content you can create and view the content on your site.
4. Structure has links to administer site taxonomies, character projects, relations and the various site layout options like blocks.
5. Appearance is where you can edit the theme of your site.
6. Under People you can administer the site’s users, including adding or removing administration privileges.
7. Configuration gives access to various advanced administration pages that you will need only rarely or not at all.
8. The Import page is the place to go when you want to import any kind of data into your Scratchpad.

Adding a page

Introduction

In Scratchpads you can create custom pages to present content in a static way. You can consider pages in Scratchpads like any other static web page. You can embed text, images or other content like...
Instructions

Adding a new page

1. From the Admin menu go to Content

2. Click Add next to Page

3. Enter a TITLE, e.g. "Introduction", and some BODY text. The SUMMARY field can be used for a short version that is displayed on search results or news pages

4. Use the MEDIA field to link media (images, audio or video) to your page. These items will appear as links beneath the text of your page

5. To add images to your text, you need to add them using the Add media icon in the BODY field
6. In **MENU SETTINGS** select where you want the page to be placed by choosing the appropriate **PARENT ITEM**. By default, a page will be set to **Main menu** (see below)

![Menu settings](image)

7. Click the **Save** button at the bottom left

**Editing a page**

1. Edit content on the page by clicking the **Edit** tab
2. The **BODY** field has a Rich text editor. Explore some of the features of the rich text editor by modifying the format of the text you have entered
3. Click **Save**
4. To create links to external pages please use an absolute URL for example for the scratchpads home page use "http://scratchpads.eu". If you want to create a link to another page or node of your site use relative URLs for example to create a link to your literature page use "/biblio" rather than "http://mysite.myspecies.info/biblio"

**Menu settings when editing a page**

1. A **MENU LINK TITLE** is required for each page. By default, the page title is used. You may want to replace the menu link if the page title is very long

![Menu settings](image)

2. The **PARENT ITEM** controls where your page will be placed on the site. **Main menu** is selected by default. It is not advisable to have all pages showing up in the Main menu, so
before you add pages think about the hierarchy of menu items and start adding the pages that should show in the main menu first

3. The WEIGHT defines where in a list of menu items this item is placed

**Cloning a page**

For cases where there are only slight differences between nodes you can create a duplicate:

1. Click on the *Clone* tab.
2. Change the *Title* of the page and some of the text
3. Switch the *parent menu* item from "Main menu" to the new menu item you created with your previous page
4. Click *Save*

Instead of popping up in the Main menu, the menu link title now appears in a block next to the page. This block will fill with a hierarchy of menu items as you add more pages. You can use it to structure your pages in a way that helps users to find the information.
Adding and managing Taxonomies

Adding a biological classification

Introduction

Before adding data other than static pages to a Scratchpad, we need to add the taxonomic names. This is done via the taxonomy module. The taxonomy module contains controlled vocabularies. A vocabulary is a list of terms. These do not have to be biological classifications. Country lists, keywords etc. can all be treated as "taxonomies" in the context of your site. Taxonomies are the backbone of a Scratchpad and link together the content. They are used to generate taxon pages. Before you add a set of taxonomic names to your Scratchpad you need to add the vocabulary for it.

Instructions

1. Click on Structure in the Admin menu and click on Taxonomy near the bottom

   ![Structure in Admin menu]

2. Click on the Add vocabulary link

   ![Add vocabulary link]

3. Minimally enter the vocabulary Name (e.g. "Lice" if you use our training materials); you can also add a Description. Select which kind of biological classification you are creating.
4. Click Save

Having created a vocabulary you now need to add the list of terms (names). This can be done by either importing a classification through the external Encyclopedia of Life service (see Import a classification from EOL) or by creating and importing your own classification (see Import your own classification). Alternatively you can add terms one by one by clicking on Add terms when you are on the Taxonomy admin page or by using the taxonomic editor (Edit terms) (see Edit a biological classification).

**Importing a classification from EOL**

*Instructions*

1. From the Admin Menu go to Import
2. From the drop-down list select the *TCS (Encyclopaedia of Life taxonomy import provider)* under the Taxonomy section
3. Select a Taxonomy
4. Click on *EOL*, enter the root term (the highest taxon for which all children will be imported) of your classification (e.g. "Pediculus" or "Pinus") in the text field and click on *Search EOL*
5. The name usually appears in several possible classifications from the EOL databases. Choose one of them and click the *Import from EOL* button. This will import the complete classification of the taxon you type, into the Scratchpad.

- When the import is complete, a link will appear in the Main menu of your site linking to the taxon pages and the taxonomic editor will open. You can learn more about how to use the taxonomic editor on the [Edit a biological classification page](#).

## Importing your own classification

**Instructions**

**Importing classification from Excel files**

1. From the Admin menu select *Import*
2. Select *Taxonomy: Excel file import*

3. Select a vocabulary, upload a file with your classification and click the *Import*.
When the import is complete, a link will appear in the Main menu of your site linking to the taxon pages and the taxonomic editor will open. You can learn more about how to use the taxonomic editor on the Edit a biological classification page.

**Viewing a classification**

1. To view your classification and the taxon pages close the overlay and go to the new tab with the classification's name in the Main menu.

2. On the left side of the page you can browse the classification. Navigate by clicking on the plus icons to view child taxa and clicking on a taxon name to open the respective taxon page.

**Deleting classification**

1. From the Admin menu go to Structure > Taxonomy
2. Select Settings next to the taxonomy you wish to delete

Click Delete at the bottom. This will delete the vocabulary as well as all the terms in this vocabulary.

**Editing a biological classification**

**Instructions**

1. From the Admin Menu go to Structure > Taxonomies
2. Click Edit terms next to the biological classification you wish to edit
3. On the left side of the page you can browse the classification. Navigate by clicking on the plus icons to view child taxa and clicking on a taxon name to open the respective taxon page.

4. In the upper right side of the page, click on the cog wheel icon next to the taxonomic name header of a taxon page and click on Edit> You are now viewing the taxonomic editor.

5. The taxonomic editor is divided into a left Tree side and right Form side. On the Tree side you can add, edit, move, delete or search for taxonomy terms. On the Form side you add/edit the data associated with a term.

6. When accessing the taxonomic editor via the classification edit function, the respective term is already in edit mode. If you instead access the editor via the taxonomy administration page or if you want to edit a different term, extend the classification to the correct term by clicking on the plus icons and select a term by clicking on the Edit link next to it.

7. Edit the term on the Form side.

8. Click Save.

9. Add a term by either clicking on the Add term icon in the upper right corner of the Tree side or on the Add term tab above the Form side. The new term will be added as child of the selected term. If no term was selected the new term is added to the root of the classification.

10. Delete a term by clicking on the Delete term icon in the upper right corner of the Tree side of the taxonomic editor.
Additional options

Add fields

If you need additional fields, for example one for type data, click on the 'Manage fields' tab. Near the bottom of the table is an option to 'Add new field'. The field type is usually "Text". After saving, more options for the field are available. You can also add a new group and move your new fields into this group. Groups show up as tabs in the taxonomic editor.
Adding content

Adding literature

Instructions

Import a bibliography

1. Click *Import* in the Admin menu and select "Nodes: Biblio file import".
2. Browse for the file (download the Biblio example file) and select the FILE TYPE. If you are using our training materials select "Endnote XML" because our bibliography has been exported from Endnote into XML format.

3. Import.
4. Click on the *x* icon in the upper right corner to close the import overlay.
5. Click on *Literature* in the Main menu and you should see all your imported records. To the left of the literature citations is the faceted browsing that allows you to filter for certain terms.
Edit a reference

1. Click on the title of any biblio entry to go to the node page for that entry. Click on the *Edit* tab.

2. You can now edit this individual entry, changing any of the fields that you consider to need changing.

3. Tag this biblio node to the classification by adding the respective term in the *TAXONOMIC NAME* field (Autotagging doesn't work for biblio nodes). Only references that are linked to the classification will show up on your taxon pages. If you are using our training material, link the record you are editing to "Pediculus humanus".

4. Click *Save*. 
**Adding a single reference**

1. Click **Content** in the *Admin menu* and then on the **Add** link for Biblio
2. Select the publication type *Journal Article* (or any type you prefer), and fill out the fields given. Remember to link this bibliographic reference to your classification by filling in the *TAXONOMIC NAME* field

3. You can also add a bibliographic record by pasting the BibTeX or RIS record or looking it up

**Adding and exporting Taxon descriptions**

**Introduction**

The Taxon description content type is based on TDWG's SPM (Species Profile Model) standard.

**Instructions**

*Adding a taxon description with distribution map*

1. From the Main menu click **Add** next to *Taxon description*
2. Add the taxon name into the Taxonomic Name field
3. Fill the fields as needed. Use the Morphology field for the actual morphological description of the taxon and Diagnostic Description for the diagnosis
4. To add a distribution map click on the Ecology and Distribution tab
5. Click on the + Polygon tab to enter a custom shaped distribution. You can move the map by dragging and dropping. Click the map to add polygon points. Right click to stop adding points. To edit an existing point click on it and drag it to a new position or right click to delete.

6. Click on the + Region tab to select TDWG regions. Select the level of the region either by zooming in or out of the map or by clicking on the Selecting by ... (Level ...) field. Then click on the map to select the respective region of this level.
7. Click **Save**

### Adding media galleries

**Introduction**

Media Galleries are used to organise Images or other media types in groups. You may use media galleries to organise your media thematically according to your needs.

**Instructions**

1. From the Admin menu go to **Content > Media gallery**
2. Click **+ media gallery**
3. Enter a **TITLE** and a short description of the gallery in the **BODY** field
4. In the Media box click on Select media and either upload a new image or, if you already uploaded images, click on the Library tab and select the image(s) you want to link to this media gallery.

5. Click Submit.

6. To change the creative commons license (the default licence is the one you chose during the set up workflow) or annotate your image in other ways (taxonomic name, imaging technique, keywords, etc.) click on Edit media next to the respective image. If you upload several images, it is faster to use the Grid editor to edit several images at once (see Edit content).
7. To add another image click the *Add another item* button and select another media file.
8. Click *Save*
9. After saving you will see your media gallery but the images will still be missing. Renew your browser page (Control+F5 on a PC) after a couple minutes to make the images appear.

---

**Adding images and other media files**

**Instructions**

1. From the Admin menu go to *Content*
2. Click on the *Add* link next to *Images* in the *Files* section at the bottom
3. Click on Add files to select one or more files to be uploaded. You may also drag and drop files in the filename box from your file explorer (e.g. windows explorer)

4. After selecting your file(s) click Start upload and wait for the files to upload
5. Click on Submit

6. Change the TITLE if necessary and fill in the other fields as needed
7. To link the image to the classification and have it show on taxon pages enter a name in the TAXONOMIC NAME field. After typing a few letters you will get a list of names starting with these letters. Choose one of these.
8. Click on the Misc vertical tab
9. Fill the Media Gallery you wish your image(s) to belong to
10. Click Save

Adding locations and specimens

Introduction

Specimen data in a Scratchpad conform to the Darwin Core (version 1.2.1) format recommended by TDWG (the Taxonomic Databases working group) and GBIF. They are separated into two content types: location and specimen, which allows you to connect different specimens at the same location.
**Instructions**

**Adding a location**

1. From the Admin menu go to **Content**

![Content screenshot](image1)

2. Click **Add** next to **Location**
3. Enter a **LOCATION IDENTIFIER**. The location identifier needs to be unique because it is used for referencing this location while adding specimens. Either click on the **Point** tab for the map to add a point to the map with a left mouse click (delete is with right click) or enter the latitude and longitude in decimal degrees (coordinate system WGS84) in the field below the map.

![Location creation screenshot](image2)

4. Click on the **<Extra Fields>** tab for additional optional fields.
5. Select a COUNTRY from the drop down menu
6. Use the LOCALITY field to enter information that is not covered in any of the other fields
7. Click Save

Adding a specimen

1. From the Admin menu go to Content
2. Click the Add link next to Specimen/Observation.
3. There are five different vertical tabs: Required, Taxonomy, Collection, Miscellaneous, and Location. Each of these tabs has different fields that can optionally be completed in order to create a new specimen record.
4. Fill out the fields under the Required tab. The two code fields together with the catalog number generate a unique ID for this specimen record that is used as the specimen title.

5. The Taxonomy tab contains the basic information about the identification of your specimen. The important field here is the second one, TAXONOMIC NAME, which is linked directly to all your site's vocabularies.
6. Fill in the information under the Collection and Miscellaneous tabs.
7. Under the Location tab, select the location you created earlier. If you haven't created a Location previously you may add one here by clicking on Create a new Location and use it here option. This new Location will be available to use for other specimens/observations in the future.
8. In addition to the fields above, you can also add a media file to your specimen record.
1. Click Save

- You can now view your specimen including thumbnails of any media you attached and a map of the location.
- Click on the Clone tab to create a similar specimen from the same location by just changing the data in the CATALOGUE NUMBER field.

In practice most people will (at least initially) want to enter locality and specimen records in bulk. This can be done by importing an Excel spreadsheet. See related pages section

**Importing data**

**Instructions**

To import data into your Scratchpad they need to be in the correct format matching the fields, and in some cases the values within these fields. To help prepare your data in the correct format you can export a template Excel file that includes all the fields and any pre-defined field values for the respective content type. Populate this file with your data and import into the Scratchpad.
Creating the template file

1. From the Admin menu go to Content
2. Click on Import next to the content type you want to create the template file for, e.g. Taxon description
3. Click on the Download link and open the file in Excel. You will see the different Scratchpad fields as column headers. Required fields are shown in Red

4. Fill the template file with your data and save

Importing the filled template file

1. From the Admin menu go to Content
2. Click Import next to the content type into which you want to import data, e.g. Taxon description.
3. From the *Maximum number of rows* drop down menu select the option that best matches your file. (e.g. for a excel file with 3500 rows, choose 5000)

4. *Browse* for the file and click on the *Import* button

5. View your imported data by clicking on the respective tab for the content type in the Main menu or by clicking on *Content* in the Admin menu and then on *View* next to the respective content type

**Other Important Information**

- **Always download an up-to-date template file** - the Excel spreadsheets can be used for most content and are dynamically generated. This means that if you add fields you will need to use a new template.

- **Be patient with importing data** - the Excel file needs to be uploaded, parsed, then saved in your Scratchpad. Upload speeds are usually much slower than download speeds, so depending on your internet connection this may take some time (especially for large files >1MB). Importing medium-sized (3000-6000 term) taxonomies with rich data can take 5-15 minutes.

- **Keep the browser window open when running an import** - if you close the browser window the import will stop.

- **If a taxonomy imports in the wrong order, try running the import again** - if you have defined parent child relationships and a child is imported before its parent, it will be placed at the root of a taxonomy. Running an import again will update the taxonomy and the hierarchical relationship should now be correct.

- **Use GUIDs if you have any** - A GUID is a global unique identifier for a record/node. GUIDs can be used to compare/synchronize different databases. Adding a GUID is not required, you only need it if your records/nodes were generated from an established database and you want to be able to update your data from this database at a later stage. Note that the GUID really has to be globally unique, at least across the whole Scratchpad. So it is not enough just add a number. Better is a combination like "Species2000-1".
**Importing classifications (taxonomies)**

*Introduction*

Taxonomic terms can be imported directly into an existing vocabulary through a pre-populated template excel file. This can be very helpful especially when large volume of terms has to be imported or when the imported terms are already in a structured (or semi-structured) format (e.g. an MS Excel file, an MS Access database).

*Instructions*

**Downloading the template file**

1. From the *Admin menu* select *Import*
2. Select *Taxonomy: Excel file import*

3. Select a vocabulary,

   Select the first template file if you wish to replace all contents of an existing classification or
   Select the second template file if you wish to update (correct, add) terms in an existing classification

*Editing the template file*

**Complete the columns as follows:**

**Term Name - Required field**

Provide the full term without the authority. e.g. “Thymus” or “Thymus longicaulis” or “Thymus longicaulis subsp. longicaulis”. Do not italicize.

Always start with the higher taxa of your classification first

**Parent Term Name**

Provide the term name of the immediate hierarchical parent in your classification. Provide the name as entered in the *Term Name* field
**Term description**

Provide some basic description for the term. This field should not be confused with the taxon description that can be entered in detail from the Taxon description content type.

**GUID**

Provide a unique and at least 10 character long alphanumeric identifier for the term. This identifier will be used throughout Scratchpads to identify this term. If left empty the system will auto-generate one once the file is uploaded.

**Parent GUID**

Provide the GUID of the parent term. This can be left empty if you have already provided the Parent Term Name or if the taxon is the highest in the hierarchy.

**Associated accepted name (Name)**

Provide the name of the term that is the currently accepted name if the taxon is not accepted. Should be left empty if the column Associated accepted name (TID) or Associated accepted name (GUID) is filled.

**Associated accepted name (TID)**

Provide the TID number of the term that is the currently accepted name if the taxon is not accepted. Should be left empty if the column Associated accepted name (name) or Associated accepted name (GUID) is filled.

**Associated accepted name (GUID)**

Provide the GUID number of the term that is the currently accepted name if the taxon is not accepted. Should be left empty if the column Associated accepted name (name) or Associated accepted name (TID) is filled.

**Authors**

Provide the abbreviated authority of the taxon.

**Page Number**

Provide the page number of the taxon description in the protologue reference.

**Rank** - Required field

Select the rank of the term.

**Reference (NID)**

Provide the NID of the protologue reference. Should be left empty if Reference (Title) is entered.
Reference (Title)

Select the Publication title of the taxon protologue. The reference should already be present in your Scratchpad. Should be left empty if Reference (NID) is entered

Unacceptibility Reason

Select the reason why this term is a not accepted taxon

Unit indicator 1,2,3,4

Select the appropriate taxonomic indicator for the parts of the term e.g. For the term *Thymus longicaulis subsp. longicaulis* Unit indicator 3 should be set to *subsp.* e.g. For the term *Mentha x piperita* Unit indicator 2 should be set to *x*

Unit Name 1,2,3,4 - Required field

Break the binomial or polynomial term down to its components e.g. For the term *Thymus* Unit name 1 should only be filled with the string *Thymus* e.g. For the term *Thymus longicaulis* Unit name 1: *Thymus* and Unit name 2: *longicaulis* e.g. For the term *Thymus longicaulis subsp. longicaulis* Unit name 1: *Thymus*, Unit name 2: *longicaulis* and Unit name 3: *longicaulis*

Usage - Required field

Select whether the term is an accepted or not accepted name. If you set it to not accepted you should also have provided *Unacceptibility Reason* and *Associated accepted name*

Vernacular name: Vernacular name

Enter the vernacular name(s) of the taxon. To enter more than one use the pipe character (|) to separate them. e.g. "thyme" and "thym" should be entered as "thyme | thym"

Vernacular names: Language*

Enter the language of the vernacular name(s). e.g. "en | fr". Accepted language abbreviations can be found at http://en.wiktionary.org/wiki/Appendix:ISO_639-1_language_codes. We use the ISO 639-1 language code standard

Vernacular names: Area from which the vernacular name usage originates

The specific description of the area from which the vernacular name usage originates. Vernacular names may have very specific regional contexts. A name used for a species in one area may refer to a different species in another.
Vernacular names: Vernacular name remarks

A description of any context that qualify the specific usage of the vernacular name.

**Uploading the classification**

1. From the *Admin menu* select *Import*
2. Select *Taxonomy: Excel file import*
3. Select the vocabulary you want to upload the spreadsheet to
4. Click *Browse* to find the file in your local computer
5. Click *Import*

**Importing locations**

**Instructions**

Excel file imports can be used either for creating new nodes or for updating existing. Check the import page for more general info.

To download the template file (for new data or for updating your data)

- Go to *Import > Nodes > Excel file import*
- Choose *locations* from the second drop-down menu
- Choose the template file you wish to work on (choose the first for creating new data or the second for changing or amending existing scratchpad data)
- Open the downloaded excel file in your computer and edit it

*Complete the columns as follows:*

![Excel spreadsheet screenshot]

- **GUID:**
  
  Use Global Unique Identifiers for each one of your localities. These identifiers will not show up to users. Use complex combinations like EU-GB-S-DK-000-001

- **Title:**
  
  The title is the location identifier and will be used to refer to each specific location in your scratchpad. Make it human readable.

- **Continent/Ocean:**
Select the continent or Ocean of your locality. Choose one from the following: Africa, Antarctic, Asia-Temperate, Asia-Tropical, Atlantic Ocean, Australasia, Europe, Indian Ocean, North-Central Pacific, Northern America, Northwestern Pacific, Pacific, South-Central Pacific, Southern America, Southwestern Pacific

- **Verbatim Coordinate System:**

Provide the name of the system the coordinates of the locality were recorded. Choose one from the following: decimal degrees, degrees decimal minutes, degrees minutes seconds, UTM, CRTM.

- **Coordinate uncertainty in meters:**

The upper limit of the distance (in meters) from the given latitude and longitude describing a circle within which the whole of the described locality lies. Leave the value empty if the uncertainty is unknown, cannot be estimated, or is not applicable (because there are no coordinates). The value should be greater than zero.

- **Country (ISO alpha-2):**

Choose the administrative region (Country) the locality is in. Please fill in the the official ISO 3166-1-alpha-2 country code. An exhaustive list can be found here.

- **County:**

Provide the the name of a second-level administrative subdivision of a country.

- **Geodetic datum:**

Provide the geodetic datum of the locality coordinates. e.g. WGS84, NAD83, NAD27 etc.

- **Georeference protocol:**

Give a citation (publication or URL) to the resource describing the methods used to determine the georeference (coordinates AND uncertainty, or footprint)

- **Georeference remarks:**

Comments about the spatial description determination, explaining assumptions made in addition or opposition to the those formalized in the method referred to in Georeference Protocol.

- **Island group:**

The full unabbreviated name of the island group for the locality

- **Island:**
The full unabbreviated name of the island for the locality

- **Locality:**

A description of the locality, without any geographic information that is provided in other geographic fields.

- **Map:**

Provide the decimal degrees of the locality in WGS84.

For example: for N40°34'50" E23°33'16" give POINT:(40.580,23.554)

Always put Long/Lat decimal degrees in parentheses separated by comma and with the prefix *POINT:*

- **Maximum depth:**

The maximum or actual depth at which the collection or observation was made. Use positive values for locations below the surface. Examples: 10 (for a depth of up to 10m). 100 (for a depth between 50m and 100m).

- **Maximum elevation:**

The minimum distance in meters above (positive) or below sea level of the collecting locality.

- **Minimum depth:**

The minimum or actual depth at which the collection or observation was made. Use positive values for locations below the surface. Examples: 0 (for a depth of up to 10m). 50 (for a depth between 50m and 100m).

- **Minimum elevation:**

The minimum distance in meters above (positive) or below sea level of the collecting locality.

- **State/Province:**

Provide the name of the first-level administrative subdivision of a country.

---

**Importing specimens**

**Instructions**

Excel file imports can be used either for creating new nodes or for updating existing. Check the import page for more general info.

To download the template file (for new data or for updating your data)
• Go to Import > Nodes > Excel file import
• Choose <specimen/observation> from the second drop-down menu
• Choose the template file you wish to work on (choose the first for creating new data or the second for changing or amending existing scratchpad data)
• Open the downloaded excel file in your computer and edit it

**Complete the columns as follows:**

• **GUID:**

Use Global Unique Identifiers for each one of your localities. These identifiers will not show up to users. Use complex combinations like DK-2012-05-20-1001

• **Basis of Record:**

This designates the type of record you enter. Please choose from: Fossil Specimen, Human Observation, Living Specimen, Machine Observation, Moving Image, Other Specimen, Preserved Specimen, Sound Recording, Still Image. Use Preserved specimen for herbarium or zoological museum specimens. This is a required field.

• **Catalogue number:**

Provide the institution number of the specimen (accession number). This is a required field.

• **Collection code:**

Provide the institution’s code for the collection in which the specimen is kept. This field is not to be misinterpreted as the institution code which is entered in a different field. This is a required field.

• **Collector (UID):**

The Unique identification number of the collector as stored in your Scratchpad. Please note that collectors should first have been registered as persons in your Scratchpad. Leave empty if you do not know this number.

• **Collector (Name on Site):**

The name of the collector as it is registered in your Scratchpad. If you filled in the Collector (UID) you do not have to enter anything here.

• **Collector number:**

The collector's number for this specific entry.

• **Count:**

The number of individuals present in the lot or container. Not to be used for observations.

• **Date collected (Start):**
The verbatim original representation of the starting date (and time) information for the collecting event. Enter dates as follows: for 25 January 1979 enter 1979-01-25

- **Date collected (End):**

The verbatim original representation of the end date (and time) information for the collecting event. Enter dates as follows: for 25 January 1979 enter 1979-01-25

- **Date identified (End):**

Date the specimen was taxonomically identified. Enter dates as follows: for 25 January 1979 enter 1979-01-25

- **GebBank number:**

GenBank Accession number(s) associated with the specimen referred to by the cataloged object.

- **Identification qualifier:**

A brief phrase or a standard term ("cf.", "aff.") to qualify the identification of the organism when doubts have arisen as to its taxonomic identity (determination). Example: 1) For the determination "Quercus aff. agrifolia var. oxyadenia", the entry in this field would be "aff. agrifolia var. oxyadenia"

- **Identified by (UID):**

The Unique identification number of the identifier (det.) as stored in your Scratchpad. Please note that identifiers should first have been registered as persons in your Scratchpad. Leave empty if you do not know this number.

- **Identified by (Name on Site):**

The name of the identifier (det.) as it is registered in your Scratchpad. If you filled in the Collector (UID) you do not have to enter anything here.

- **Institution code:**

The institution code that holds the specimen referred to by the cataloged object. This is a required field.

- **Lifestage:**

The age class or life stage of the specimen

- **Location (NID):**

The identification number of the location the specimen was collected from or the observation made in. You can find this number by browsing through your location list in your Scratchpad. Please note that entering the locations used in this field is a pre-requrement. You can see the permitted values for this field on the `permittedValues` tab of the downloaded excel file.

- **Location (title):**
The title of the location the specimen was collected from or the observation made in. If you entered data in the Location (NID) field you should not enter anything here. You can see the permitted values for this field on the permittedValues tab of the downloaded excel file.

- **Field Notes:**

Field notes associated with the specimen or observation

- **Field number:**

An identifier given to the event in the field. Often serves as a link between field notes and the Event.

- **Other catalogue numbers:**

A list (concatenated and separated) of previous or alternate fully qualified catalog numbers or other human-used identifiers for the same Occurrence, whether in the current or any other data set or collection.

- **Remarks:**

Comments or notes about the Event.

- **Sex:**

The sex of the specimen. Permitted values: Female, Hermaphrodite, Indeterminate, Male, Multiple, Transitional, Undetermined, Unknown

- **Taxonomic names:**

The taxonomic name the specimen or observation was identified as. Use a term from your existing biological vocabularies. Check permitted values on the same column of the PermittedValues tab in the downloaded excel file.

- **Type status:**

Indicates the kind of nomenclatural type that a specimen represents. Permitted values: Holotype, Isotype, Lectotype, Neotype, Nontype, Not Provided, Paralectotype, Paratype, Syntype
Finding and editing content

Searching content

Introduction

There are several ways to find specific content on a Scratchpad: Search, faceted search, Main menu and Admin menu.

Instructions

Searching

The Search box in the header has different search options: All and Taxonomy. All finds all content that includes the search term. Taxonomy only searches for terms in one of the vocabularies and returns the matched terms. When you are viewing a page ("Page" content type) you will get an additional option to search only page content. Clicking on the <Search> button when the search field is empty will lead to a faceted search page.

Faceted Search

Some pages provide the option of faceted search in a separate block on the left of the page. Faceted search can be used to filter the nodes of a content type (e.g. References). To use the faceted search:
- Fields with less than 20 terms show up as a list. Click on a term to restrict results for this term.

<table>
<thead>
<tr>
<th>BIBLIO: TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Artwork (1)</td>
</tr>
<tr>
<td>Audiovisual (3)</td>
</tr>
<tr>
<td>Case (21)</td>
</tr>
<tr>
<td>Conference Proceedings (5)</td>
</tr>
<tr>
<td>Journal Article (1)</td>
</tr>
<tr>
<td>Miscellaneous (266)</td>
</tr>
<tr>
<td>Statute (11)</td>
</tr>
</tbody>
</table>

- Fields with more than 20 terms also provide an autocomplete search box. Fill in the term and press enter or else select from the list.

<table>
<thead>
<tr>
<th>BIBLIO: AUTHOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter author name...</td>
</tr>
<tr>
<td>Abdelqawad, M M (1)</td>
</tr>
<tr>
<td>Abousaber, M (1)</td>
</tr>
<tr>
<td>Abu-Darwish, M S (1)</td>
</tr>
<tr>
<td>Abu-Ghazaleh, B M (1)</td>
</tr>
<tr>
<td>Achouri, M (3)</td>
</tr>
<tr>
<td>Adzet, T (3)</td>
</tr>
<tr>
<td>Agency, European Environment (2)</td>
</tr>
<tr>
<td>Ahmed, B (1)</td>
</tr>
<tr>
<td>Akqul, A (1)</td>
</tr>
<tr>
<td>Akqul, A (1)</td>
</tr>
<tr>
<td>Akcin, TA (1)</td>
</tr>
<tr>
<td>Al Khateeb, W (1)</td>
</tr>
<tr>
<td>Al-Howiriny, T A (1)</td>
</tr>
<tr>
<td>Al-Tawaha, A R (1)</td>
</tr>
<tr>
<td>Albert, M J (1)</td>
</tr>
<tr>
<td>Alcazar, M D (1)</td>
</tr>
<tr>
<td>Aleksovski, S A (1)</td>
</tr>
<tr>
<td>Ali, S M (2)</td>
</tr>
<tr>
<td>Almaiwal, A (1)</td>
</tr>
<tr>
<td>Alu'datt, M H (1)</td>
</tr>
</tbody>
</table>

- You can remove a filter by clicking on the (-) sign next to a selected term.
• You can filter the content based on multiple fields

*Find content via the Main menu*

Click on one of the content types in the Main menu to find the respective data. Several content types, like literature and media gallery offer faceted browsing for smarter and more powerful searching.

*Find content via the Admin menu*

As maintainer of a site you can also find content via the Admin menu.

• Click on `<Content>` in the Admin menu and then on `View` next to the content type that included the data you need to find.

This way you can only find content by content type. The advantage is that you can find content that is not published which is otherwise difficult. Additionally, you can search by username or do operations like deleting or (un)publishing several nodes at once.

*Find recent content via the dashboard*

You can customize your dashboard to show recent content.

**Editing content**

*Introduction*

Content can either be edited by going to the respective node and clicking on the `<Edit>` tab or by using the grid editor to update several nodes at once.

*Instructions*

1. Click `<Content>` in the Admin menu
2. Click `<Grid>` next to the for a content type you wish to edit
3. You will see a matrix with a row for each node and columns for selected fields of this content type. The rows are ordered chronologically, with the most recent nodes at the top
4. If the fields of the respective content type are sorted into groups on different tabs, these tabs will show in the grid editor, too. To gain more space for viewing a certain column the column sizes can be adapted by moving the column separators or by hiding columns by right clicking on the column header and deselecting columns.

5. To edit contents of a single cell click into the cell, edit and click Save

6. To edit the same field in several nodes, select the respective nodes by checking the box to the left of the row. Then click into the cell you want to edit for one of the nodes, edit and click Save. The content of this field will change for all selected nodes.

7. To filter for certain content click on the little magnifying glass in the upper right corner of the matrix and enter the search word in the search box that appears for each column. You can sort the rows by clicking on the column header of the field you want to sort by.

8. At the bottom of the matrix there are icons for cloning (create a duplicate entry), deleting and undoing.
Selecting external services

Linking to Google Scholar

Instructions

1. From the administration menu bar got to Structure > Tools
2. Find the Widgets section
3. Click on the switch next to Google Scholar Widget to enable it (ON)
4. Click Save

- Once enabled, the widget will be visible as a new section called Google Scholar in the Literature tab of your taxonomy viewer.
- Only the first 20 returned results are visible in this section
- Click on the title to access the abstract (or full article) of the reference. All links will open in a new browser tab.
- Click on View all results on the Google Scholar to see all the results for the taxon in Google Scholar site.

When no data are returned from Google Scholar the section will not be visible.

Linking to BHL

Instructions

Enabling the widget

1. From the administration menu bar got to Structure > Tools
2. Find the Widgets section
3. Click on the switch next to BHL Widget to enable it (ON)
4. Click Save

Accessing widget results

Once enabled, the widget will be visible as a new section called Google Scholar in the References tab of your taxonomy viewer.

1. Find the taxon you are interested in by browsing your classification
2. Click on the Literature tab
3. Find the Biodiversity Heritage Library section. Only the first 20 returned results are visible in this section.
4. Click on a title to see the pages that mention the taxon name.
5. Click again on the title to access the full record through the BHL in a new tab.
6. Click on the page number to open an overlay window to view the corresponding page.
7. Click on View all results on the BHL website to see all the results for the taxon in BHL site.

When no data are returned from BHL this section will not be visible.

Linking to IUCN data

Instructions

1. From the administration menu bar got to Structure > Tools.
2. Find the Widgets section.
3. Click on the switch next to IUCN Widget to enable it (ON).
4. Click Save.

Once enabled, the widget will appear as a new section called IUCN in the Descriptions tab of your taxonomy viewer.

When no data are available from IUCN service for a taxon the following message will appear: “The IUCN does not hold any information for [taxon name]”
Linking to NCBI

Instructions

Enabling the widget

1. From the administration menu bar got to Structure > Tools
2. Find the Widgets section
3. Click on the switch next to NCBI Widget to enable it (ON)
4. Click Save

Accessing widget results

Once enabled, the widget will be visible as a new section called NCBI in the Description tab of your taxonomy viewer.

- A table will provide results associated with a taxon from all NCBI's databases; including Nucleotides and Proteins.

1. Click on the Subtree or Direct links number to directly access the NCBI data
2. Click on External links to expand it. These links are taxon related links to other third party resources, as provided by the NCBI API.

Adding RSS feeds

Introduction

RSS Rich Site Summary is a family of web feed formats used to publish frequently updated works—such as blog entries, news headlines, audio, and video—in a standardized format. An RSS document (feed) includes full or summarized text, plus metadata such as publishing dates and authorship.
You can set up Scratchpads so that selected pages in your site show these feeds. You can also format them according to your needs.

To implement the use of RSS feeds in your site you will need to edit:

- The Feed aggregator module
- Views and
- Blocks

**Instructions**

**Entering RSS feed URLs**

1. From the administration menu bar (top of page) go to Configuration > Web Services > Feed aggregator
2. You can organise your feeds in categories. To add a new category of Feeds (e.g. News) click on + Add category
3. Fill in the title and description of the category and click Save
4. Click on + Add feed
5. Add the title of your feed and the URL of the feed location. For example the RSS feed location of BHL is http://www.biodiversitylibrary.org/RecentRss/100
6. Select the interval period the system will update the feed from the source site
7. Select the number of items you wish to be displayed at once from the feed
8. Select the category of your feed. If you haven't created any categories you will not see the Categorize News Items section here
9. Click Save

You can repeat the above procedure as many times as your different RSS feeds are.

**Checking if the feeds work**

1. Go to Feed aggregator overview page
2. Review the RSS feeds you created
3. Click on update items on each row
4. Check whether the items column is greater than 0 items. If it is equal to 0 you probably have entered a wrong RSS feed URL

**Creating a new View**

1. From the administration menu bar (top of page) go to Structure > Views
2. Click + Add new View
3. Fill a name for your new View. This can be related to the content of the RSS feeds you wish to include in this view (e.g. External news)
4. To put a description tick the description box
5. Select Aggregator Item from the drop-down list next to SHOW
6. If you want your feeds to be visible as a separate page tick Create a page. If you wish RSS feeds to show as blocks in selected existing pages click Create a block. You can select both
Creating a View page

1. Give a title to the page that will present your feeds
2. You can leave the path as it is or change it to a more brief one
3. In Display format select the way you would like the feed items to be formatted. Choose between HTML List, Slideshow, Table and Unformatted list
4. Select the number of items you wish to be visible at once
5. Select *Use a pager* if you with the feed items to be paginated
6. Select *Create a menu link* for the page to be visible in a site’s menu
7. Select *Include an RSS feed* to create a RSS feed for others to use in their sites
8. Click on *Continue & edit*

Creating a View Block

1. Give a title to the block
2. In Display format select the way you would like the feed items to be formatted. Choose between HTML List, Slideshow, Table and Unformatted list
3. Select the number of items you wish to be visible at once
4. Select *Use a pager* if you with the feed items to be paginated
5. Click on *Continue & edit*

Editing the new View

You can edit the view at any time by going to *Structure > Views > Name of View* and click on *Edit* on the right

Editing the View Page

1. Under *Displays* Select the *Page* box
2. Click on *add in Fields section*
3. Tick the boxes: *Aggregator:Title, Aggregator:Body, Aggregator:Author*. You can also add any other fields you would like to be displayed for each feed item
4. Click *Apply (all displays))*
5. Expand the *Advanced* section on the right side
6. Click *add’ in Contextual filters*
7. Tick *Aggregator: Category ID* to select the feeds you wish to include based on the category they belong OR tick *Aggregator: Feed ID* to select individual feed(s) you wish to include
8. Click *Apply (all displays))*
9. In the next screen select *Provide default value* under *When the filter value is not provided by the URL*
10. Select *Fixed value* under *TYPE*
11. In the *FIXED VALUE* field provide the ID of the category (if you selected Aggregator:Category ID in step 7) or else the feed ID. You can select multiple categories or feeds separated by comma. (e.g. 2,3). To check the ID of a feed or a category go to Configuration > Feed aggregator, click on the title of the Category or feed and write down the number after /categories or /sources (e.g. thymus.myspecies.info/aggregator/sources/2) in the URL of the page.
12. Expand the *More* section of the overlay page
13. Tick *Allow multiple values* if you used multiple categories or fields in step 11
14. Click *Apply (all displays)*
15. To change the settings of the format of feeds click *Settings* in the *Format* section > *Show*
16. When finished Click *Save* on the top right corner of the page
17. You can view the new page by clicking on the menu item created

**Editing the View Block**

1. Under *Displays* Select the *Block* box
2. Click on *add* in *Fields* section
3. Tick the boxes: *Aggregator:Title, Aggregator:Body, Aggregator:Author*. You can also add any other fields you would like to be displayed for each feed item
4. Click *Apply (all displays)*
5. Expand the *Advanced* section on the right side
6. Click *add’ in Contextual filters*
7. Tick *Aggregator: Category ID* to select the feeds you wish to include based on the category they belong OR tick *Aggregator: Feed ID* to select individual feed(s) you wish to include
8. Click *Apply (all displays)*
9. In the next screen select *Provide default value* under *When the filter value is not provided by the URL*
10. Select *Fixed value* under *TYPE*
11. In the *FIXED VALUE* field provide the ID of the category (if you selected Aggregator:Category ID in step 7) or else the feed ID. You can select multiple categories or feeds separated by comma. (e.g. 2,3). To check the ID of a feed or a category go to Configuration > Feed aggregator, click on the title of the Category or feed and write down the number after /categories or /sources (e.g. thymus.myspecies.info/aggregator/sources/2) in the URL of the page.
12. Expand the *More* section of the overlay page
13. Tick *Allow multiple values* if you used multiple categories or fields in step 11
14. Click *Apply (all displays)*
15. To change the settings of the format of feeds click *Settings* in the *Format* section > *Show*
16. When finished Click *Save* on the top right corner of the page
17. A new block has been created with the name you provided when creating the View Box. To view the block and change its properties from the administration menu bar click Structure > Blocks > Name of Block

**Inserting a Block in a page**

In order for your feeds to be visible from in selected existing Scratchpad pages you will have to enable this Block. To do so please follow the Instructions in Enabling Blocks
**Twitter feeds**

**Instructions**

1. Edit your page or block.
2. Make sure that you edit the content of a page having the text format set to Filtered HTML.

3. Use the following string where you want the feed to appear: `[TWITTER:{hashtags}]`
4. Replace `{hashtags}` with the hashtags you want the feed to search for.
5. Separate hashtags with a space. For example: `[TWITTER: #naturalhistorymuseum #scratchpads]`
Administrator’s Tasks

Adding and Editing Users

Introduction

You can control user access under People in the Admin menu. The People page allows you to list all users of your site and perform actions (upgrade, delete, edit) on them.

When a new user creates an account, the site maintainer will receive an email and will have to unblock them and add a user role before they can use the site.

There are four user roles:

- **Authenticated** (unblocked) user: Able to access non-public content, create and edit own forum posts
- **Contributor**: Able to create content and edit own content
- **Editor**: Able to create and edit own content, and also edit other people's content
- **Maintainer**: Like editor, but also has administration privileges

Instructions

**Adding a new user**

1. Go to People in the Admin menu
2. Click Add user at the top of the overlay
3. For users that are allowed to log in, you need to check the Allow user to login? box at the bottom
4. Complete all the relevant boxes with example data (compulsory fields are marked with a red asterix)

**Authorising new user accounts**

1. Go to People in the Admin menu
2. Check the status and role of the user(s) you want to edit. Newly signed up users will have a status of "blocked"
3. Click the check box to the left of their username and select “Unblock the selected users” then click Update

Changing existing user roles

1. Go to People in the Admin menu
2. Check the role of the user(s) you want to edit
3. Click the check box to the left of their username and add or remove the required role then click Update

Editing the front page

Instructions

1. Click on the Home icon to go to the front page. As part of the set up workflow you will have produced a welcome message for your front page.

2. To the right of the welcome message is an image block. If you haven't added any images, yet, this space will be empty. (See add images)
3. Below welcome message and images is a row of three blocks. These blocks are only visible when content is available for the respective content types. As part of the set up workflow you will have produced an about page, which shows up in the Recent pages block. The other two blocks are showing recent biblio nodes and taxon descriptions.
4. Click on the Edit tab above the welcome message to have a look at the blocks. At the top of the overlay you can edit the welcome message if you want. At the bottom you can select
which small blocks to show on the front page. The default is for Page, Biblio, and Taxon description.

5. Change the blocks to content types that are most useful for your site. These blocks will always show teasers of the most recent posts for the respective content type without them having to be promoted to front page. Save.

Additional information

The image block consists of four thumbnails and one larger image. The larger image changes to the image the mouse hovers over. The first four images you add to your Scratchpad will automatically be added to the front page (See Add images and other media files. After this only selected images are
shown on the front page. To select an image edit the image and go to the <Publishing options> tab at the bottom of the page. Select <Promoted to front page>. You should also select <Sticky at top of lists> for the one image you want to show in the large image space. Save.

**Customizing dashboard**

**Instructions**

1. Click on Dashboard in the Admin menu. By default the Dashboard shows the Recent content block. You can add more blocks by clicking on the Customize dashboard link at the top.

2. A selection of inactive blocks is shown in black at the top. Drag and drop these blocks into the columns below. The wider column to the left is the main dashboard area, the smaller column to the right is called the sidebar area.

3. Click the Done link to go back to view the dashboard.

**Adding a forum**

**Introduction**

Forums are basic communication tools between Scratchpads community members. They facilitate public discussions on selected topics. To create forums you first have to enable this functionality from the Scratchpads administration menu.
Instructions

Enabling the Forums module

1. From the Admin menu bar go to Structure > Tools
2. Find the Core section and enable Forums
3. Click Save

Adding a forum topic

1. Click Content in the Admin menu and then on the Add link for Forum topic.

2. Enter the SUBJECT and choose the forum in which you want to submit your topic. By default Scratchpads have only one forum that is called "General discussion". Enter the text of the topic in the BODY field
3. Click Save
4. To reply to a forum topic use the <Add new comment> function.

You can access the forum by clicking on the Forums link in the Main menu.

Creating a forum

1. Click on Structure in the Admin menu and click on Forums
2. To add a new forum click on *Add Forum*, enter the name of the forum a description and a parent term if you want a hierarchy of forums.
3. Click *Save*.
4. You can also add containers to group related forums together.

**Integrating a forum in your e-mails**

You can integrate your forum with your email to receive/send messages from/to the forum. This is done via your user account.

1. To access your account click on *Hello [your username]* in the upper right corner and then click on the *Forum/E-mail integration* tab.
2. You can subscribe to specific or all forums and also enter additional email addresses.
Adding a blog

Introduction

Blogs are used to create and manage a series of regular content entries, like general status updates, a travel diary or a running commentary. Readers can optionally comment on blog entries. They are a good way of communicating with the users of a Scratchpad.

Instructions

1. To enable the blog go to Structure in the Admin menu and click on Tools. In the Core section enable blog and save.

2. Click Content in the Admin menu and then on the Add link for Blog entry.

3. Enter the title and some body text
4. Click Save
5. You can find your newly created blog entry in the Blogs tab in the Main menu.
The **Blogs** tab shows the blog entries from all users. You have the options to view only blog entries from a single user by opening a blog entry from this user and clicking on the link to this user's blog that is below the blog entry. Alternatively go to the user’s account and use the link there.

---

### Enabling Google Analytics

**Introduction**

Google Analytics helps you get an overview over the number of visitors on your site, where they come from and how they behave.

**Instructions**

1. Go to [http://www.google.com/analytics/features/index.html](http://www.google.com/analytics/features/index.html) and create a Google Analytics account for your Scratchpad. You will be given a key that starts with "UA-". Save this key or keep this page open while you enable the Google Analytics module on your Scratchpad.
2. To enable Google Analytics on your Scratchpad go to **Structure** in the **Admin menu** and click on **Tools**. In the **Statistics** section, enable Google Analytics and click **Save**.
3. Configure the Google Analytics tool by clicking on the **Configure Google Analytics** link that has appeared in the **Statistics** section. Alternatively go to **Configuration** in the **Admin menu** and click on **Google Analytics**.
4. In the **WEB PROPERTY ID** field enter the the **UA number** given by Google when you signed up. Save.
5. After about a day you should be able to see the first data about your Scratchpad when you log into your Google Analytics account. You can only view these data via your Analytics account, not via your Scratchpad.
281 people visited this site

Visits: 410
Unique Visitors: 291
Pageviews: 1,251
Pages / Visit: 3.05
Avg. Visit Duration: 00:32:15

- 65.94% New Visitor
- 34.06% Returning Visitor
Help and support

Help and tips for working with Scratchpads can be found on the help wiki at http://help.scratchpads.eu

For feature requests and bug reports please use the Issues tab which appears on the left hand side of your Scratchpad when you are logged in. If you have specific questions or would like advice or help in how to best set up your site, please email the Scratchpad team at support@scratchpads.eu. Don't be afraid to ask 'stupid' questions and don't get hung up on a problem for hours. In some cases the solution might be easy (you just have to know it...) in others it might be a bug only our developers can solve.

Feedback

To help us improve these courses please fill out the feedback form at

http://scratchpads.eu/training-course-feedback